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SAFETY SUMMARY 
 
 
The following general safety precautions must be observed during all phases of operation and 
maintenance of this instrument. Failure to comply with these precautions or with specific warnings 
elsewhere in this manual violates safety standards of design, manufacture, and intended use of the 
instrument. Boonton Electronics assumes no liability for the customer’s failure to comply with these 
requirements. 
 
 
DO NOT OPERATE THE INSTRUMENT IN AN EXPLOSIVE ATMOSPHERE 
Do not operate the instrument in the presence of flammable gases or fumes. 
 
DO NOT OPERATE THE INSTRUMENT OUTSIDE 
This instrument is designed for indoor use only. 
 
KEEP AWAY FROM LIVE CIRCUITS 
Operating personnel must not remove instrument covers. Component replacement and internal 
adjustments must be made by qualified maintenance personnel. Do not replace components with the 
power cable connected. Under certain conditions dangerous voltages may exist even though the power 
cable was removed, therefore; always disconnect power and discharge circuits before touching them. 
 
DO NOT SERVICE OR ADJUST ALONE 
Service and adjustments should be performed only by qualified service personnel.  Do not attempt internal 
service or adjustment unless another person, capable of rendering first aid and resuscitation, is present. 
 
DO NOT SUBSTITUTE PARTS OR MODIFY INSTRUMENT 
Do not install substitute parts or perform any unauthorized modifications on the instrument. Return the 
instrument to Boonton Electronics for repair to ensure that the safety features are maintained. 
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SAFETY SYMBOLS 
 

This safety requirement symbol has been adopted by the International Electro-technical 
Commission, Document 66 (Central Office) 3, Paragraph 5.3, which directs that an 
instrument be so labeled if, for the correct use of the instrument, it is necessary to refer to 
the instruction manual. In this case it is recommended that reference be made to the 
instruction manual when connecting the instrument to the signal source and USB host. 

 
 

The CAUTION symbol denotes a hazard. It calls attention to an operational procedure, 
practice or instruction that, if not followed, could result in damage to or destruction of 
part or all of the instrument and accessories. Do not proceed beyond a CAUTION symbol 
until its conditions are fully understood and met. 

 
 

The NOTE symbol is used to mark information which should be read. This information can 
be very useful to the operator in dealing with the subjects covered in this section. 

 
 

The HINT symbol is used to identify additional comments which are outside of the normal 
format of the manual, however can give the user additional information about the 
subject. 
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1 Introduction 

1.1 Overview 
This document describes the setup and usage of the CPS2000-Series True-Average Connected Power 

Sensors, CPS2000 GUI application software, Boonton CPS2000 IVI.NET driver software, and Boonton 

CPS2000 IVI-C driver software. 

 

 
 

 

1.2 Definitions 
Term/Abbreviation Definition 

VISA 
Virtual Instrument Software Architecture. A test & measurement 
device I/O specification. 

IVI 
Interchangeable Virtual Instruments. A test & measurement device I/O 
specification layered above VISA. 

PoE 
Power over Ethernet. A system or method by which power is passed 
along with data via Ethernet cabling. 

LAN Local Area Network 
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2 Setup & Installation 

2.1 System Requirements & Dependencies 

2.1.1 CPS2000 GUI System Requirements 

The CPS2000 GUI software application’s minimum system requirements are as follows: 

Operating System Windows 7 SP1 or newer (32- and 64-bit) 

Processor 1 GHz CPU 

RAM 1 GB RAM 

Disk Space 512 MB of Available Disk Space 

Graphics DirectX 9 Compatible Integrated or Dedicated Graphics Card 

Other .NET Framework 4.0 or later – Included with the CPS2000 GUI application installer 

Table 1 - Minimum System Requirements 

 

2.1.2 CPS2000 GUI Software Requirements 

To communicate with power sensors, the Boonton Power Viewer software application makes use of the 

Boonton CPS2000 IVI.NET driver. 

The Boonton CPS2000 IVI.NET driver is an IVI-Compliant driver included as part of the CPS2000 GUI 

application installer. Also included with the CPS2000 GUI application installer is the Boonton CPS2000 

IVI-C driver. 

The Boonton CPS2000 IVI-C driver has the following software prerequisites: 

Software Minimum Version 

VISA Shared Components 5.6.0 

IVI Shared Components 2.4.2 
Table 2 - IVI-C Driver Prerequisites 

The Boonton CPS2000 IVI.NET driver has the following software prerequisites: 

Software Minimum Version 

VISA.NET Shared Components 5.6.0 

IVI.NET Shared Components 1.4.0 
Table 3 - IVI.NET Driver Prerequisites 
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2.1.2.1 IVI Shared Components Availability 

The IVI and IVI.NET Shared Components required by the CPS2000 GUI software application and IVI 

drivers are included with the CPS2000 GUI application installer. 

Alternatively, the shared components are available from the official IVI foundation website:  

http://www.ivifoundation.org  

 

2.1.2.2 VISA Implementations and Availability 

The VISA and VISA.NET Shared Components are not included with the CPS2000 GUI application installer.  

Known compatible VISA implementations, and their required minimum version, are listed below: 

Vendor Software 
Minimum 
Version 

Recommended 
Version 

Download Location 

National 
Instruments 

NI-VISA 15.0.1 17.0 
http://www.ni.com/download/ni-visa-
17.0/6646/en/ 

Keysight 
IO 

Libraries 
Suite 

17.2.20407.1 18.1.22713.0 https://www.keysight.com/find/iosuite  

Table 4 – VISA Implementations & Availability 

The recommended VISA implementation is NI-VISA 17.0 provided by National Instruments. 
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2.2 Installation 
 

Note! 

Installation and operation of the CPS2000 GUI requires installation of the IVI.NET, IVI, 

VISA.NET, and VISA shared components. The IVI.NET and IVI shared components are 

included with the CPS2000 GUI software installer, but the VISA shared components are 

only obtainable from a 3rd party vendor. These components must be installed before using 

the CPS2000 GUI software. See section 2.1.2. 

Installation of the CPS2000 GUI software application Boonton CPS2000 IVI drivers can be performed 

using the CPS2000 GUI software application installer available on Boonton’s website. 

The setup installer includes the CPS2000 GUI software application, the required IVI Shared Components, 

and Boonton CPS2000 IVI drivers. 
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3 General Use & Configuration 

3.1 Connecting to a Power Sensor 
The CPS2000 series of devices supports connection via USB and Ethernet (TCP/IP). Specifically, the 

supported modalities are as follows: 

 

Connected to PC via USB. 
Powered by the USB connection to the PC. 

 

Connected to PC via Ethernet LAN (TCP/IP). 
Powered by PoE (Power over Ethernet). 

 

Connected to PC via Ethernet LAN (TCP/IP). 
Powered by USB Power Adapter. 

 

Connected to PC via Ethernet LAN (TCP/IP). 
Powered by USB connection to the PC. 
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3.1.1 USB 

All CPS2000 power sensors support connection to a PC using USB. 

3.1.1.1 Required Equipment 

a) CPS2000 Power Sensor 

b) USB 2.0 Type A Male to Type B Male cable 

c) PC with the CPS2000 GUI application installed 

3.1.1.2 Setup Steps 

To setup and take measurements with a CPS2000 power sensor connected by USB, follow these steps: 

1. Connect the CPS2000 power sensor to the PC using a standard USB 2.0 Type A Male to 

Type B Male cable. 

2. Start up the CPS2000 GUI application. 

3. The CPS2000 power sensor will appear in the device list. Select the device and click OK to 

open the device. 

 

Figure 1 - USB Device Selection 

4. The application will immediately begin taking power measurements. 

 

 Start Simulated Device 

When a CPS2000 power sensor is not available, users may still access the CPS2000 GUI by 

selecting the Start Simulated Device button.   
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3.1.2 Ethernet 

The CPS2000 power sensors also support connection to a LAN network via standard Ethernet cabling. 

3.1.2.1 Required Equipment 

a) CPS2000 Power Sensor 

b) CAT5 or CAT6 Ethernet Cable 

c) Local network with router setup and configured 

d) PoE (“Power over Ethernet”) Ethernet switch or USB wall power source 

e) PC with the CPS2000 GUI application installed 

 

Note! 

When using the device via an Ethernet connection, the device must be powered using PoE 

or with a USB power adapter. The device does not support connection to a PC via both 

Ethernet and USB at the same time. 

 

3.1.2.2 Setup Steps 

To setup and take measurements with a CPS2000 power sensor connected by Ethernet, follow these 

steps: 

1. Connect the CPS2000 power sensor to your LAN using a standard Ethernet cable. 

a. If not using Power over Ethernet, connect the CPS2000 power sensor to a power using 

a USB power adapter. 

2. Start up the CPS2000 GUI application. 

3. Select Manually Enter IP Address button. 

4. Enter the IP address of the device.  

 

Note! 

To determine the IP address of a CPS2000 power sensor, users need to connect to the 

sensor via USB. Then go to the File -> Configure Network Settings… menu and select the 

sensor in question.  A Network Configuration window will appear with the information.  

Please see section 3.1.2.3 for additional information. 
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5. The software will then verify the IP. 

  

Figure 2 - TCPIP Search Success 

6. Click OK to open the device. 

7. The application will immediately begin taking power measurements. 

 Auto-detect 

 If the Cancel button is selected, the user will be returned to the Open Device window with 

Auto-Detect of USB devices disabled.  To return to the Open Device window with Auto-Detect 

with Auto-Detect enabled, select the Back to Auto-Detect button. 

 

3.1.2.3 Configuring the TCP/IP Settings of a Power Sensor 

To configure the TCP/IP settings of a Power Sensor, select the device you want to configure under the 

File -> Configure Network Settings… menu: 

 

Configure the settings as required using the input boxes within the New Settings section of the window. 

When finished, click the Store New Settings… button to apply the changes.  
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 3-5 GENERAL USE & CONFIGURATION Page 16 



 CPS2000 Series Instruction Manual 

 

3.2 Configuring a Power Sensor 
The CPS2000 GUI application provides a simple device configuration UI. 

 

Figure 3 - Software Overview 

1 Settings panel, including Frequency, 
Aperture, and Offset settings. 

 3 Units selection 

Aperture 
1 ms - 2 s 

The aperture time is the total time the 
sensor observes the input signal to 
make one power measurement. 

 4 Visualization selected. Options 
include Text-Only, Gauge-Only, and 
Text + Gauge. 

Offset 
+/-200 dB 

This feature provides the ability to 
apply corrections to measurements 
when RF devices are between the 
sensor and DUT. 

 5 
 
6 

Power Measurement 
 
Add Device… button for adding 
additional devices 

2 Live Power vs. Time graph 
(units are dBm only) 

 7 Applied settings 

  

1 

2 

3 6 

4 

7 

5 

Always-on-Top  
Feature 

Show/Hide 
Global 

Settings 
Panel 

Show/Hide 
Y-Axis 

Configuration 

Undock & resize 
Live Power graph 
with Always-on-

Top feature 
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3.3 Connecting to Multiple Power Sensors 
The CPS2000 GUI application supports connecting multiple devices. To connect to additional devices, 

click the Add Device… button. 

To toggle the view between single and multiple sensor readings, navigate to View -> Graph -> All 

Channels or No Channels. 

 

 

Figure 4 - Multiple Device View 
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1 Global settings panel, affects all devices 
that are linked to the global settings 

 5 Applied device settings for each device 

2 Device label – A user configurable label 
for a Power Sensor or Ratio 

 6 Toggle buttons to configure or remove a 
specific Power Sensor or Ratio 

3 Color selector  7 Adds a ratio between two power 
measurements 

4 Graph toggle checkbox    

 

3.4 Upgrading the Firmware on a Power Sensor 
To determine the current firmware version on a CPS power sensor, navigate to Device -> View Detailed 

Information -> and select the sensor of interest.   
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To upgrade firmware, the CPS2000 GUI application includes a utility for loading firmware onto a 

CPS2000 power sensor. The utility is accessible using the File -> Upgrade Device Firmware… menu: 

 

Figure 5 - Firmware Upgrade Menu 

To load new firmware onto a power sensor, select it from the list of devices, select an upgrade file, and 

then click the Start Upgrade button. 

      

 

Figure 6 - Firmware Upgrade Process 

When the firmware loading process has completed, the power sensor will automatically be reconnected 

and power measurements will automatically startup again. 
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3.5 Other Features 
The CPS2000 GUI includes additional features described below.   

 

3.5.1 Set Display Refresh 

Users can select the display refresh rate from x to y.   

3.5.2 Show Low Power Readings 

The CPS2000 power sensor can detect power levels below the specified measurement range.  Users can 

elect to display these readings by selecting Show Low Power Readings.  Otherwise, the when power 

levels are below the specified range, the display will read “Too Low” (default setting).   
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4 Troubleshooting 

4.1 Recovery After a Failed Firmware Upgrade 
If a failure is encountered when attempting to upgrade a device, such as if the cable is disconnected 

during an upgrade, the device may be left in a state that prevents operation of the normal upgrade 

procedure. 

If this occurs, the device can still be recovered. To recover the device, follow these steps: 

1. Open a Windows Command Prompt window

2. Within the command prompt, navigate to the CPS2000 GUI application’s directory:

> cd C:\Program Files(x86)\Boonton\CPS2000

Note: This location depends on the location where the application was installed. If 

you installed the application to a different location, you will need to use a different 

path. 

3. Execute the following command, replacing <path> with the path to your firmware upgrade

.sb file.

> blhost.exe --usb 0x1cb5,0x2000 receive-sb-file <path>

4. Allow the upgrade to complete.

5. When finished, execute the following command:

> blhost.exe --usb 0x1cb5,0x2000 reset

6. The device will reset and will then be available for use in the CPS2000 GUI application.

5 Boonton Resources on RF Power Measurements 

Information regarding power measurement and Boonton Power Sensor products is available free of 
charge from the Resource Library section of the Boonton website. All Boonton power sensor instruction 
manuals cover the details of RF power measurement techniques. The following links highlight a few of 
the available application notes, articles, webinars and white papers related to RF Power measurements 
and techniques: 

• Principles of RF Power Measurements:

https://boonton.com/resource-library/principles-of-power-measurement-guide
• Videos:

https://boonton.com/resource-library/videos
• Application Notes:

https://boonton.com/applications
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• Whitepapers:

https://boonton.com/resource-library/white-papers 
• Articles:

https://boonton.com/resource-library/articles
• Webinars:

https://boonton.com/resource-library/webinars
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Appendix A – Software License  

END-USER LICENSE AGREEMENT  
License below is hereby granted for the following product(s):  

• Boonton CPS2000 Series True-Average Connected Power Sensors  

 
IMPORTANT-READ CAREFULLY: This End-User License Agreement ("EULA") is a legal agreement between 
you (either an individual or a single entity) and Boonton Electronics, a subsidiary of the Wireless 
Telecom Group, Inc., for the Boonton Electronics software product identified above, which includes 
instrument software and may include associated media, printed materials, "online" or electronic 
documentation, and Internet-based services ("Product"). An amendment or addendum to this EULA may 
accompany the Product.  
 
YOU AGREE TO BE BOUND BY THE TERMS OF THIS EULA BY INSTALLING, COPYING, OR OTHERWISE 
USING THE PRODUCT. IF YOU DO NOT AGREE, DO NOT INSTALL OR USE THE PRODUCT; YOU MAY 
RETURN IT TO YOUR PLACE OF PURCHASE FOR A FULL REFUND.  
 
1. GRANT OF LICENSE. Boonton Electronics grants you the following rights provided that you comply 

with all terms and conditions of this EULA:  

• Installation and use. You may install, use, access, display and run this Product only in 
conjunction with a Boonton CPS2000 Series True-Average Connected Power Sensor. The Product 
may not be used on any other hardware.  

• Reservation of Rights. Boonton Electronics reserves all rights not expressly granted to you in this 
EULA.  

 
2. UPGRADES. To use a Product identified as an upgrade, you must first be licensed for the product 

identified by Boonton Electronics as eligible for the upgrade. After upgrading, you may continue to 
use the product that formed the basis for your upgrade eligibility.  

 
3. TRANSFERABILITY. This product is transferable only to other Boonton models listed in Paragraph 1.  
 
4. LIMITATION ON REVERSE ENGINEERING, DECOMPILATION, AND DISASSEMBLY. You may not reverse 

engineer, decompile, or disassemble the Product, except and only to the extent that it is expressly 
permitted by applicable law notwithstanding this limitation.  

 
5. TERMINATION. Without prejudice to any other rights, Boonton Electronics may cancel this EULA if 

you do not abide by the terms and conditions of this EULA, in which case you must destroy all copies 
of the Product and all of its component parts.  

 
6. NOT FOR RESALE SOFTWARE. This software product is "Not for Resale" and may not be separately 

resold, transferred or used for any purpose other than operation with Boonton instrument models 
listed in the paragraph 1. 

 
7. EXPORT RESTRICTIONS. You acknowledge that the Product is of U.S. origin and subject to U.S. export 

jurisdiction. You agree to comply with all applicable international and national laws that apply to the 
Product, including the U.S. Export Administration Regulations, as well as end-user, end-use, and 
destination restrictions issued by U.S. and other governments.  
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8. U.S. GOVERNMENT LICENSE RIGHTS. All Product provided to the U.S. Government pursuant to 
solicitations issued on or after December 1, 1995 is provided with the commercial license rights and 
restrictions described elsewhere herein. All Product provided to the U.S. Government pursuant to 
solicitations issued prior to December 1, 1995 is provided with "Restricted Rights" as provided for in 
FAR, 48 CFR 52.227-14 (JUNE 1987) or DFAR, 48 CFR 252.227-7013 (OCT 1988), as applicable.  

 
9. APPLICABLE LAW. If you acquired this Product in the United States, this EULA is governed by the 

laws of the State of New Jersey. If this Product was acquired outside the United States, then local 
law may apply.  

 
10. ENTIRE AGREEMENT. This EULA (including any addendum or amendment to this EULA which is 

included with the Product) are the entire agreement between you and Boonton Electronics relating 
to the Product and the support services (if any) and they supersede all prior or contemporaneous 
oral or written communications, proposals and representations with respect to the Product or any 
other subject matter covered by this EULA. To the extent the terms of any Boonton Electronics 
policies or programs for support services conflict with the terms of this EULA, the terms of this EULA 
shall control.  

 
11. The Product is protected by copyright and other intellectual property laws and treaties. Boonton 

Electronics owns the title, copyright, and other intellectual property rights in the Product. The 
Product is licensed, not sold.  
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Appendix B – Warranty & Repair  
 

B.1 Repair Policy  
If a Boonton power sensor is not operating correctly and requires service, contact the Boonton 
Electronics Service Department as indicated in Section B.2 Contacting Boonton for return authorization. 
You will be provided with an RMA number and shipping instructions. Customers outside the USA should 
contact the authorized Boonton distributor for your area. The entire instrument must be returned in its 
original packing container. If the original container is not available, Boonton Electronics will ship a 
replacement container and you will be billed for the container cost and shipping charges.  
 
Note that sensors which have failed due to overloading, improper mating, or connecting to an out-of-
tolerance connector are not considered defective and will not be covered by the Boonton Warranty. 
 

B.2 Contacting Boonton  
RMAs for service or calibration may be obtained directly from the Boonton website:  
https://www.boonton.com/service-and-support/request-an-rma 
 
Customers in the United States having questions or equipment problems may contact Boonton 
Electronics directly during business hours (8 AM to 5 PM Eastern) by phoning (973) 386-9696. FAX 
messages may be sent at any time to (973) 386-9191.  
 
Email inquiries should be sent to service@boonton.com. International customers should contact their 
authorized Boonton Electronics representative for assistance. A current list of authorized US and 
international representatives is available on the Boonton website at https://www.boonton.com/. 
 

B.3 Limited Warranty  
Boonton Electronics warrants its products to the original Purchaser to be free from defects in material 
and workmanship and to operate within applicable specifications for a period of three years from date 
of shipment for instruments, probes, power sensors and accessories. Boonton Electronics further 
warrants that its instruments will perform within all current specifications under normal use and service 
for three years from date of shipment. These warranties do not cover active devices that have given 
normal service, sealed assemblies which have been opened, or any item which has been repaired or 
altered without Boonton’s authorization.  
 
Boonton’s warranties are limited to either the repair or replacement, at Boonton’s option, of any 
product found to be defective under the terms of these warranties.  
 
There will be no charge for parts and labor during the warranty period. The Purchaser shall prepay 
inbound shipping charges to Boonton or its designated service facility and shall return the product in its 
original or an equivalent shipping container. Boonton or its designated service facility shall pay shipping 
charges to return the product to the Purchaser for domestic shipping addresses. For addresses outside 
the United States, the Purchaser is responsible for prepaying all shipping charges, duties and taxes (both 
inbound and outbound).  
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At Boonton's option, an extended Warranty period may be available for an additional charge. If an 
extended warranty option has been purchased, the extended period is substituted for the 3-year period 
above. Note that the extended warranty does not extend the instrument's calibration interval past 12 
months. The instrument must be maintained in a calibrated state throughout the warranty period to be 
eligible for warranty service to remedy "out of spec" operation.  
 
THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE. Boonton will not be liable for any incidental damages or for any consequential 
damages, as defined in Section 2-715 of the Uniform Commercial Code, in connection with products 
covered by the foregoing warranties. 
 

 
  

Wireless Telecom Group Inc. 
25 Eastmans Rd 

Parsippany, NJ 07054 
 United States of America 

Tel: +1 973 386 9696 
Fax: +1 973 386 9191 
https://www.boonton.com/ 

 
© Copyright 2022 

All rights reserved.   
 

Note: Specifications, terms and conditions 
 are subject to change without prior notice. 
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